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Introduction

QUES$TOR has been designed to produce high level estimates of the
capital and operating costs of green field oil and gas developments. It
will assist with project modelling, evaluation and subsequent decision
making in the oil and gas industry.

QUES$TOR provides a reliable, consistent methodology for producing
cost estimates and creates efficiency when optimising field
developments. It has benefits in many applications, including:

« Prospect evaluations
« Screening studies
Feasibility studies
Conceptual studies
Optimisation studies

QUES$TOR uses a systematic approach to generate a field development
basis, capital and operating costs, and project schedules from basic
field data. QUE$TOR uses a bottom up methodology; the calculations
are based around detailed sizing algorithms and engineering “rules of
thumb” with regional variations where appropriate.

This approach allows engineers, estimators and economists to produce
weight and cost estimates quickly, consistently, and accurately and to
develop investment profiles.

This guide is designed to help you understand the operation of the
QUES$TOR program, outlining the basic steps involved in developing a
QUES$TOR project to produce a scheduled estimate for capital and
operating costs. When you are running QUE$TOR, press the F1 key to
access the QUE$TOR Help file for more detailed guidance.
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Estimate Basis

The following points should be considered when generating or reporting
a cost estimate using QUE$TOR.

QUES$TOR provides an estimate based on the costs within the
markets today. We make no allowance for inflation or deflation of
costs over the project life

All of the costs within QUE$TOR are in real terms

Pre-sanction project costs such as environmental studies, FEED
and licensing costs can be optionally included

Post-sanction costs such as owner’s project management costs,
legal costs and security costs can be optionally included
Contingencies within QUE$TOR are calibrated to target the P50
development cost

QUES$TOR is designed for use early in the project cycle. Therefore
the estimate level that can be attained by using the program is
typically within the range of +/- 25% to 40%

The estimate produced is dependent on user entered values.
Therefore, any estimate should take into account the confidence
of these values.

IHS
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About the Quick Start Guide

This guide is designed to help you understand the operation of the
QUES$TOR program, outlining the basic steps involved in developing a
QUES$TOR project to produce a scheduled estimate for capital and

operating costs.

QUES$TOR is structured around a field development schematic (FDS)
which allows you to create a visualisation of the development. The FDS
is driven by a number of high level inputs which allow the development
conditions to be specified. The basic program calculation sequence
followed in QUE$TOR to generate a full life-cycle field or prospect
development cost estimate is shown below.

Create Project
Cffshore / Onshore

!

i Project Properties
Select location, product
and databases

!

Field Level Data
Define reservair and field

characteristics
e "

!

Production Profile |

Define profiles, capacities
and number of wells

¥

Concept Selector
Select development
concept

¥

Field Development
Schematic
Adjust concept

r
Component Details
Madify and confirm
component design

-

LY

.

b .
¥
OPEX
Calculate field OFEX
b
- * ™

CAPEX Scheduling
Schedule CAPEX and
production start

¥

Investment and
Production Profile

Generate report
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To define the new project, QUE$TOR presents you with a series of
forms that allow high level parameters of the development to be
specified. The Field level data form is populated with default values for
the basin selected in the Project properties form. Subsequent forms
have values and selections based on earlier entries. Once you have
reviewed and adjusted as necessary the default inputs in each form,
click on OK to apply the inputs and move on to the next form. Click on
Cancel to ignore changes made and go back to the previous form and
make any necessary revisions.
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Getting Started

QUES$TOR must be installed on a local PC. This must be done by a local
administrator. See the release notes for installation instructions.

QUES$TOR will run on these following operating systems:
« Windows Vista
« Windows 7
« Windows 8
« Windows 10

A licence must be available; either a standalone dongle which plugs
directly into your computer or a network licence which is accessible
across your company's local area network. QUE$TOR Offshore,
QUES$TOR Onshore and QUE$TOR LNG Regasification require separate
licences. Contact your IT department for further details.

Depending on your installation options, you can launch QUE$TOR either
from the taskbar Start button or from your PC desktop.

From the taskbar Start button

Click Start and follow All Programs> IHS > QUE$TOR 2016 Q1 >
QUES$TOR 2016 Q1

From your PC desktop
Double-click the QUE$TOR 2016 Q1 application shortcut icon.
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Creating a New Project
On opening QUE$TOR the task selection form will appear.

Select a task to perform

Create a new project

(%) Mew offshore project

) Mew onzhore project

Open exizting project

) Browse for project...

31 My Documentz\HSSIUE $TOR YProjects\Cluster

) 2 My Documents\HSAIUE $TORProjects\E xample 4
) 3 My Documentsy HSAAUE $T DR ProjectshE xample 3
) 4 My Documentsy  HSAAUE $T ORAProjectshE xample 2
) 5 My Documents\HSAIUE$T DR \Projects\E xample 1

[ ok H Caricel ]

On this form you can choose to create a new project or open an existing
project. For new projects you can either create a new offshore project
or a new onshore project. For existing projects there are shortcuts to
the last five projects saved.

The location of your wells should determine whether you pick offshore
or onshore as the start point. If you are running a combined offshore
and onshore project then the second location can be selected later in
the project estimate.

Once you have selected your project location i.e. offshore or onshore,
click OK to move onto the Project properties form. QUE$TOR will check
that you have a valid licence to run the selected project type at this
point.

IHS May 2016 Page 9



QUES$TOR 2016 Q1 Quick Start Guide

Selecting the Project Properties

The project properties allow you to setup the basic information about
your project including the procurement strategy, regional technical
database and units set preference.

Project properties

M ame | Mew offshare project |

IIrits of measure

(® Use buiin unit st | Dilfeld v

() Use custom unit set |

b air product

@ oil () Gas

Location
Regiorn warldwide ]
Contry | Worldwide Average = |
Eazin / play |Wnrldwide Average = |

Frocurement ztrategy

C:ADocumentz and Settingshdpa854534bdy Documentz\ HSAAUE$T OR\Procurement Str | [ Browse. ]

M ame Last modifie. .. Last modified Yerzion [ Mew ]

Worldwide dyverage dpagh459 2030116 0352 131 [ i ]
(=T

[ Delete l

Technizal database

M arne 5. E. &szia | Browsze...

[+] Praceed directly ta field schematic [ (] ] [ Cancel ]

Work through the following steps to set up your project:
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« Give your project a name.

« Select the units you want to work in. Pick from one of the standard
unit sets provided or create your own using the Unit editor tool. For
the majority of users one of the default unit sets should meet your
needs as you can change each unit as needed throughout the
program.

[nits of meazLre

(%1 Usge buil-in unit set Oilfield

() Usge custom urit get

« Select the main product. For Oil projects you will have to define
your recoverable oil reserves and a gas oil ratio, while for gas
projects you will input your recoverable gas reserves and a
condensate gas ratio.

b ain produict

& oil () Gas

« Select the geographical region, country, and basin to enable
QUES$TOR to seed your project with typical basin specific data
generated from the IHS IRIS21 E&P database. This selection will
also drive the default location of a new procurement strategy and
will set your regional technical database.

Location
Reqion Whiorldwide bt
Country Worldwide Average hs
Baszin / play Worldwide Average b

« Create your procurement strategy. This can be done by clicking
the New button. This will display the Define procurement strategy
form shown below. Procurement strategies allow you to choose
different regional cost databases for each cost centre. By default
all costs are reported in US Dollars but this can be edited by
changing the currency name, symbol and exchange rate at the top
of the form.
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Define procurement strategy - Worldwide Average

Mew procurement strateqy cumency

Mame |L|S Diollars | Symbal Exchange rate [per US$)
Difshare |

Exchange
Cost databaze Currency [perralflegﬁ
Contingency ||3u|f of Mesico v| |L|S Dallar | | 1 |
E quipment |Gulf of Mexico w | |L|S Dallar | | 1 |
Materialz ||3u|f of Mexico v| |L|S Dallar | | 1 |
F abrication |Gulf of Mesico w | |L|S Doallar | | 1 |
Linepipe 5. E. Asia v | |US Dolar [ 1]
Inztallation ||3u|f aof Mexico w | |L|S Doallar | | 1 |
Dezign and Project management | Gulf of Mexica w | |L|S Crollar | | 1 |
OPEX | Gulf of Mevico v | [US Dallar [ 1]
Certification | Gulf of Mexico v | |US Dolar '
Freight | Gulf of Mesic v | [US Dallar [ 1]

[ ]9 ] [ Cancel

« Select the technical database to use for your project. By default
this will be the region which you have selected for your
project. Use Browse to select an alternative or user modified

database if required.

Once you have completed the above steps, click OK to move onto the

Field level data form.

Page 12
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Entering Your Field Level Data

The Field level data form contains three tabs which list the values for the
field characteristics, fluid characteristics and some miscellaneous data
respectively.

Field level data (offshore)

Field charactenstics | Fiuid / profile characteristics | Miscellaneous
Field data
Recoverable reserves 253 | Mbbl
Gas oil ratio 1320 zcf/bbl
Reservair depth fram LAT 27390 m
Reserair prezsure 261 | bara
Reservair temperature TET T
Reservair length T2 km
Reservoir width 25E| km
Water depth 171 | m

[ (] H Cancel ]

The information entered varies slightly depending on whether you have
selected an offshore or onshore project. Default values are populated
from a database relevant to the basin you selected in the Project
properties form.

On this form, modify the data to the specifics of the field that you want
to produce an estimate for. The purpose of the default data is to
provide a reasonable value where none is known and therefore you
should use your values over these defaults. Any input value can be
changed by simply over-typing it.

In this form, and any other form, the individual input units can be
changed ‘on the fly’ by clicking on the unit to the right of the value and
selecting the unit you wish to use from the options available, this is
shown for the recoverable reserves input below.
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Field level data (offshore)

Field charactenstics | Fluid / profile characteristics | Miscellaneous |

Field data
Recoverable rezerves | 175 MMBE g ¢ T
Gas oil ratio 1650 sci/bt MM (rnillion cubic metre)

MMhbbl {million barrel)

Reservoir depth from LAT 2260| m MMcF (million cubic Foot)
: { Mm® (thousand cubic metre)

Reservair pressure 251 | bara Tcf (trillion cubic Fook)

: Mbbl (thousand barrel)
Reszervair length ' 5.92| km Mef (Ehousand cubic Fook)
Reservair width ' = G | ferm
Wwater depth ' 179| m

| oK ][ Cancel ]

Once you have entered / confirmed the data on all three tabs click OK
to move onto the Production profile edit form.
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Creating a Production Profile

The production profile is created through two forms; the first form gives
seven entries through which you can influence the basic parameters of
your production profile.

Production profile edit

Orstreamn days 3501 day

Concurrent driling operations 1

Wells per pear per operation 117

Plateau rate [daily equivalent] BE | Mbbl/day

V'ears to plateau 1| pear

Plateau duration 4| vear

Field life 1| year

[ 0k l [ Canicel ]

Enter any of the values you know at this point and then click OK to move
onto the Production profile form which gives you a visual representation
of these values.

The production profile is displayed in a graphical and tabular format
across four tabs; oil (or condensate), gas, water and gross liquids.
Numbers in blue can be edited; nhumbers in black such as those in the
gross liquids tab are derived numbers and therefore can't be edited.
This colour convention applies throughout QUE$TOR.
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Production profile

& (& =
Ol Gas Water | Gross liquids
Daily Production {Hydrocarbon Liquids) Mew offshore project
70
G0
50
=
L'[E'i 40
2
= 30
20
10
0
1 2 3 4 5 6 7 g8 9 10
Years
Froduction  ;  Units ] Z 3 4 5 B 7 8
Daily " Mbbliday 330000 66000 66000  GGODD  GEOD0 53454 48064 38856
Annual MMbblfyr 115500 23100 231000 23100 23100 20800  16E22 13538
Cumulative  MMbhl 11550 34650 57750  80.850 103950 124759 141581 155181
< ¥
[ Feldaste | [ Modfy profie | Graph| Daiy Production v [ ok J[ Cancel |

You can change the production for each year by entering the values in
the table at the bottom of the form. This can either be typed in year by
year or you can paste in a profile from an external spreadsheet through
a right mouse click. You can overwrite either the daily or annual
flowrates but not the cumulative row of the table. You can also copy the
data in the production profile and paste it into an external spreadsheet.

A
% Note: When pasting in a production profile from a spreadsheet
ensure that the field life specified in the production profile edit form is
the same as that of the profile you are pasting in.

Once you are happy with the production profile, click OK to move onto
the Design flowrates form.
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Setting the Design Flowrates

The Design flowrates form gives the flowrates that will be used to
design the facilities within your project.

Design flowrates

Peak dailly average production rates

Peak daily average EE | Mbblday
Drezign ratez

Design factor 1.1

Qil production flowrate 726 Mbbl day
Azzaciated gas flowrate 120 MMz day
Gross liquids flowrate 80.7 | Mbbl day

Water injection
W ater injection capacity factor 11

W ater injection fow [1.1  grozs liquids rate] 88.7 | Mbbl/day

33z injection

Gas injection flowrate 1207 Mz day

[ Q. H Cancel ]

The production values are based on the peak production with a design
factor for oil projects giving an allowance for day to day variation, and a
swing factor in gas projects giving an allowance for seasonal demand
variation.

The injection values should be adjusted based on your pressure
maintenance and gas disposal assumptions. Water injection is assumed
by default for all oil projects.

Once you are happy with the design flowrates, click OK to move onto
the Number of wells form.
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Setting the Number of Wells

The Number of wells form, shown below, sets the total number of wells
required across the field.

Number of development wells

Cevelopment wells

Production 11
Water injection £
Gas injection 4
Total 20

Preduction well count is the higher of the
two numbers from:

(a) A well productivity of 16 MMbblfwell
(b} A peak well flow of & Mbbl/day

[ ok [ Cencel |

The default number of production wells is based on the recoverable
reserves, well productivity, plateau production and peak well flow. The
default number of water injection wells assumes an average of two
injectors for every five oil production wells. Gas injectors are based on
an average flowrate of 30 MMscf/day per well.

Modify the well count to match your design assumptions and click OK to
move onto the Wellhead conditions form for onshore projects or the
Concept selector form for offshore projects.
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Setting the Wellhead Conditions

The Wellhead conditions form is only available for onshore projects and
provides the wellhead conditions of the primary streams.

Wellhead conditions

Design welhead pressure

Flowing wellhead pressure barg

Flowing wellhead temperature

Water injection pressurs harg

(Gas injection pressurs 205 | barg
Gas Iift pressurs harg

[ ok [ Concel |

Water injection, gas injection and gas lift pressure are only relevant if
these services are selected. Adjust the conditions as necessary and
then click OK to move onto the Concept selector form.
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Selecting a Concept - Offshore

The Concept selector form allows you to choose the basic concept of
your field development.

Concept selector

MNew |

Development concept
| Production platform A

Production facilties with oil/gas processing, drlling and living quarters on a fixed steel jacket.

Cil export

Method ||:ui|:ue|i|'|e to shore w

Digtance to delivery paint lern

Gas disposal

Method |i|1jeu:1 into reservoir w

Distance to delivery pairt I:l i

[ ok ][ Cancel |

QUE$TOR selects a field development concept based on the field level
data and production profile. You can change this to another of the 14
default concepts using the list box. If you want to configure your
concept from scratch, select 'Blank concept'.

Based on your concept, QUE$TOR will select typical oil and gas export
options. Adjust these to match your desired product export routes.

When you click OK QUE$TOR runs the complete cost estimate using
program defaults throughout and displays the field development
schematic along with the cost summary tree.
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Selecting a Concept - Onshore

The Concept selector form allows you to choose the basic concept of
your field development.

Mew | Last selected

Development concept

“Wellpad group to main production faciliby w

“Wwellpads directly tied back to production facilities with oil/gas processing and product export faciliies to a terminal
and/or gaz gnid.

Product destination

il Inland terminal “ LPG MHone A
Gaz Gaz gnd w Gazoline Mone w
MGL Mone
[mports
wiater Aquifer w | Distance to main production facility 1| km
Dizpozal
W ater MHone w
Infrastacture

Infrastructure

Diztances
Digtance from main production facility to inland terinal 150 km
Distance from main praducthion facility to gas expart location B0 km

I 0k H Cancel ]

QUES$TOR selects a field development concept based on the field level
data and production profile. You can change this to another of the 6
default concepts using the list box. If you want to configure your
concept from scratch, select 'Blank concept'.

Based on your concept, QUE$TOR will select typical oil and gas export
options. Adjust these to match your desired product export routes.
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When you click OK QUE$TOR runs the complete cost estimate using
program defaults throughout and displays the field development
schematic along with the cost summary tree.
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Using the Field Development Schematic

On selecting your concept and clicking OK QUE$TOR will move through
to the main field development schematic.

. QUESTOR - New offshore project g@gl

File Project Options Reports Tools Help
PEE RE Fu~ & @
Component Cost [million $) #|| @ Oifshore [primam] | Onshore | LMG regas onshore
= @ Mewe offshore project L443.279 —n T -
= i Topsides 2 30,995 $ g ﬁ & ‘pl @ 5 . fﬁ ° ﬁ - e
Equiprent 34,260 : ) =
Materils 6,299 9 @ 9 ﬁ
Fabrication 10,360
Installation 10,091 A
Hook-up and commissi. . 3711
Design & Project man... 14,751 -
Insurance & Certificat. . 3.181 ;i
Contingency 8.272
= Jacket 2 87.470
ﬂ Materials 20,154
Fabrication 25.476
Installation 23.085
Design & Project man... 7744 4 o
Insurance & Certfficat. .. 3.059 wi
Contingency 7.952 M
= | || offshore driling 2 142,658 |||
Enuipment 33.956 ||‘| ".
Makerials 29.184 I '.‘ \ I".
Installation 48,305 F/A\ j{ W
Design & Praject man. . zes |/ o /NS
Insurance & Certificat. . 4.572 - ) I ~
Contingency 23,776
= g Topsides 1 531,838
Equiprnent 183,934
Materials 61.412
Fabrication 71.251
Installation 24.667
Hook-up and cormmissi. . 36.667
Design & Project man... 85,342
Insurance & Certificat. . 18.596
Contingency 48,349
= | W] Jacket 1 164,175
Materizls 40,658
Fabrication 54.440
teillatiom e roc o B
| < >
Feady E-mail support  IHS online commurity

The field development schematic shows the components within your
chosen concept on the right hand side of the screen, with the associated
high level CAPEX summary on the left hand side of the screen.

The schematic can be changed by adding and removing components.
You can select components to add from the component toolbar at the
top of the screen and click on the schematic to place the component. To
delete a component hit delete when the component is selected or right
click on the component and select Delete. You will be asked to confirm
any deletions to prevent any components being inadvertently deleted.

Components often require links so that the correct data can flow
between them. Components are linked using the link icon in the toolbar

ﬁ Once you have linked two components you may need to add a
pipeline by double clicking on the link.
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v
Q) Note: Connections from drilling components, subsea, and wellpad
groups do not require pipelines to be specified.

Each component will be estimated using default assumptions based on
the data you have entered so far. To view a component in detail you can
double click on it or right click on it and select Edit / view cost
estimate.
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Adjusting a Component

You can view the details of each component by either double clicking on
the component icon in the field development schematic or by right
clicking on teh icon and selecting Edit / view cost estimate.

< QUESTOR - New offshore project E@@
File Project ©Options Repaorts Tools Help
0= & [& [ w - & @
Component Cost [million $) ~
-~
;Zt:?::t 1:22;; Topsides 1 | Name | Topsides 1|
Fabrication 52362
Installation 21.621 TOTAL COST | US Daollars | 415,81 4,|]|]I]|
Honk-un_and cammissi. . 29,657 ¥
Facilities: Total dry weight 8.6531e [12.835te Op.]
ﬂ. WMarifolding a (Gagifive] e G EQUIPMENT Procured from: Gulf of Mexico
ﬂ_ Qil processing h;: Drilling Facilities — EUA? I TE 0]
tanifolding 67 te 36.000} 2,412,000
E3 0i expor EJ Quatters Muliphase meters (05 Mbbl/day) i 360,001 b
k::_ Gas processing a Frocess utiities tultiphase meters [B-20 Mbbl/day] 0 H50,000) il
&3 Gias compression &3 Flare structure tultiphase meters [20-75 hbblday] 0 210,000 il
ﬂ_ “wiater injection a Power generation Oil processing
Y Custom equipment Separation B2 te 56,000} 3,472,000
. Dehydration Ote 3,000} il
Heating 4te 3,000} 27E.000)
Frimary | Configuration | Export | Design conditions Shell & tube coaling te 59,000 1,449,000
Functions Fin fan cooling Ote 32,0004 1]
wellhead Driling 0il export Bate 42.400) 3,731,000
Praduction Quarters Gas processing
Compression Gas cooling
- Shel & lube [ ot | 53,000 0
Eepacties Fin fan [ EE 32,000 1,088,000
0il / condenzate V2.6 Mbbl/day Acid gas removal
‘i ater injection 88.7 | Mbbl/day Amine # physical solvent e 33,5001 1,462,000
Export # flared gas 0 MMsct/day Zinc oxide vessel Ote 47,0004 i}
Gas injection 120] Mbsci/day Zinc oxide be}:l Ote 2,800 0
Gas fft 0 MMscf/day Gias dohdrabon
Glycol 54 te 33,5004 2,133,000
Molecular sieve vessel Ote 46,5001 0
Malscular sieve bed Ote ¥.E00 0
Dewponiing
I TS / ruchanner nte | &4 nnnl nl o
Fieady E-mail support  [HS online community | 13.1.0.174 - 16-4pr-2013

Each component has two main parts to it: the inputs, where you can
adjust the design parameters, and the cost sheet, where you can see
the detailed breakdown of the cost.

You can make changes within each of these areas and when you click
Apply or OK these changes will be applied to the component and the
CAPEX estimate adjusted accordingly. Clicking on OK will also exit the
component. Clicking Cancel also exits the component; however you will
lose all changes made since you entered the component.

Inputs

The left hand side of the screen contains the main input data for that
component. The input form for the topsides component is shown below.
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Facilities
E3 Manifolding
ﬂ_ il proceszing
ﬂ_ il export
ﬂ_ Gaz proceszing

ﬂ_ Gaz compression

ﬂ_ ' ater injection

ﬂ_ Cuztom equipment

ﬂ_ Control and comms

EJ Diilling facilties
E3 Quarters
ﬂ_ Procezs utilities

E3 Flare stucture

E3 Power

Frimary | Configuration | Export | Design conditions

Functions
Wellhead
Production

Comprezsion

Capacitiez

0il / condenszate
Wwiater injection
Export / flared gaz
[3az injection

G az lift

Diilling

[uarters

72.6| Mbbl/day
858.7 | Mbbl/day
0 Misct/day

120 MMsct/day

0 Misct/day

The input form shows the main design parameters for a given
component, such as the design flowrates. You can make changes to
these values to match your design assumptions. When you click Apply
these changes will be applied to the component and the CAPEX
estimate adjusted accordingly.

Sub-components

There are arrow buttons £ within many components that can be clicked
on to open up one of the sub-components; the details of that system
are then shown. The topsides Manifolding sub-component form is
shown below.
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Manifolds and accessories

Service Platfarm Remate Remate Flawrate Multiphaze Operating Design Weight
wells wells rigers metering pressure plessure

=

Production 3 1 106 MbhlAday
Test

il 35 bara 153 barg 431 te

=

il 35 bara 153 barg 868 te
HIPPS

O

‘Water injection 4 3

129| Mbbl/day 146 | bara 157 | barg 101 | te

Gas injection i) 1] 1 0| MMsck/day

|

Gas lift il il

o

0| Mbdsch/day
‘well kill 261 bara 202 | barg 409 te

Contral package

B E

3|te

Hydraulic power

&

28| te

Number of well baps 1 M anifaldz and accessones total 71.75 | te

Figging

Subszea pig launchers and receivers [F]

You can make changes within each sub-component and when you click
OK these changes will be applied to the component and the CAPEX
estimate adjusted accordingly.

Cost sheet

The right hand side of the screen has the cost sheet. This shows a
detailed breakdown of the CAPEX estimate for the component. Each
line item is made up of a quantity and a unit rate.

QUAMTITY LIMIT RATE CasT
3 150 te £3.500 4,425,000

The quantity is calculated from the design parameters and technical
algorithms for that item and the unit rate is taken from the selected
procurement strategy. You can overwrite any of the blue values within
the cost sheet, as shown for the quantity entry above. Numbers in black
are derived by multiplying the quantity by the unit rate so can’t be
overwritten.
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Calculating the Operating Costs

The operating cost calculations should be run once you have finished
the design of your development as the costs are based on the technical
definition of the development.

The OPEX algorithms are run by selecting OPEX from the Project
menu. This will open a separate window where a summary of the
operating costs for each year of production is displayed.

Operating expenditure analysis

g = &

Offshore operating cost summary

Totals ear 1 rear 2 ear 3 ‘rear 4 ear 5
Grand total operating cost $ 660,040,000 60667000 62,459,000 62.459.000 67,702,000 67.215.000

Direct costs
Operating personnel costs b 141,400,000 14,140,000 14,140,000 14,140,000 14,140,000 14,140,000
Inspection & maintenance costs 4 150,239,000 13,466,000 13,486,000 13,466,000 13,466,000 13.776.000
Logigtics & consumables costs $ 135,630,000 13,333,000 13,663,000 13,663,000 13,663,000 13,663,000
‘wiell costs $ 38,169,000 1,341,000 2,445,000 2,445,000 E.633,000 5,940,000
Insurance costs $ 44,260,000 4,426,000 4,426,000 4,426,000 4,426,000 4,426,000
Direct costs total % 509,758,000 48,706,000 48,140,000 48,140,000 52,334,000 51,945,000
Field / project costs $ 150,282,000 13,961,000 14,319,000 14,319,000 15,368,000 158,270,000
T ariff casts % 1] 1} 1] 1} 0 a
CO2 emizzion takes $ 1] 0 1] 0 1] o
Leaze costs b 1] 1} 1] 1} 0 a
< >
[ ak ] [ Cancel ]

The costs are broken down into various categories, which can be seen
on the left side of the screen. The detailed breakdown of these cost
categories can be seen by clicking on these items, they are formatted
as blue hypertext. This will open up further definition sheets for you to
review or adjust the default values.

Once you are happy with the operating costs, click OK to go back to field
development schematic so that you can generate the project schedule.
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Scheduling the Capital Costs

The CAPEX scheduling calculations should be run once you have finished
the design of your development as the schedule and costs are based on
the details of the development.

The CAPEX scheduling module can be accessed by selecting
Scheduling from the Project menu. The schedule will be shown as a
Gantt chart along with the underlying data for each component.

CAPEX scheduling

&[4 [=] BB il |[E  Ccaknds 2017] Zoom [100% v

Start  Duration Cost Dist
[mth] [mths] [million $] ) [ 12 18 24 30 36 42 43 54 &0 66 72

Fad

Activiby

Pre-sancbon costs

Total costs 1] [ 55,380 N
Post-sanchon costs

Total costs 9 L1} 166139
Topsides 1

Total CAPEX 9 36 h26.543
Jacket 1

Total CAPEX 10 kil 177.077
Oil pipeline [offgshore 1)

Total CAPEX 18 24 116.843
Offzhore dnilling 1

Total CAPEX 12 55 287129

| N

I ]S H Cancel ]

For each component, a detailed schedule can be viewed by expanding

the component using the icon. You can adjust the start date and

activity duration either by dragging the bars within the Gantt chart or by
adjusting the corresponding values in the table. Adjusting these values
will change when the calculated CAPEX values are to be spent.

Once you are happy with the project schedule, click OK to go back to
field development schematic so that you can generate the Investment
and production profile.
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Generating the Investment and Production
Profile

The investment and production profile is run by selecting Investment
and production profiles from the Project menu.

The investment and production profile gives a report of all of the values
that could be required to run an economic analysis, with the production,
CAPEX and OPEX given for each year of the project. The values in this
report are in real terms, i.e. they are costs specific to a particular point
in time (depending on the version) and have not been inflated or
discounted over the life of the project.

This report can be printed or exported to Excel using the toolbar
buttons.
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Saving Your Project

Projects are not automatically saved in QUE$TOR. We recommend you
save your project when you reach the field development schematic and
at regular intervals after this.

To save a project select Save or Save As from the File menu or click on

the Save project button ® . This will enable you to save the project in
the usual Windows fashion. The default location for saved projects is
‘My Documents\IHS\QUE$TOR\Projects’.

Saved project files have a “.qpr” file extension and include the selected
procurement strategy, technical database and unit set. Once saved,
projects are completely standalone and have no further interaction with
QUES$TOR’s databases. This means that saved projects can easily be
sent to others who may not have the same databases.

Saved projects can be moved, copied and renamed using Microsoft
Windows Explorer in the same way as any Windows file. Projects can be
opened either directly from Windows Explorer or from within QUE$TOR.
To open a saved project in QUE$TOR either select Open existing
project from the form that appears when QUE$TOR starts or select
Open from the File menu.

y
% Note: When you create a new project you won't be able to save
the project until you reach the field development schematic.

Opening a Saved Project

To open a saved project select, using the option buttons, Browse for

project and click OK to proceed or click on the Open project button =
. This will enable you to open a project in the usual windows
fashion. The Open existing project box has shortcuts to the last five
projects opened in QUE$TOR. Saved projects have a “.qpr” file
extension.
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Contacting customer support

As part of the continuing licensing agreement for QUE$TOR, IHS offers
a full technical support service via its regional offices. Both computing
and engineering support relating to the operation and understanding of
the program are available.

The QUES$TOR support group has a dedicated support email address:
support_guestor@ihs.com

/
% Note: Thereisan's', nota'$'in questor in the email address.

The IHS software support team key contacts are as follows:
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North & Central
America

South America

Europe, Africa
Middle East

&

Jonathan Stephens - Product Manager,
jonathan.stephens@ihs.com

Abhishek Verma - Senior Field Development Engineer,
abhishek.verma@ihs.com

Zayd Wahab - Cost Analyst, zayd.wahab@ihs.com

5333 Westheimer
Houston

Texas 77056

USA

Tel: (+1) 713 840 8282
Fax: (+1)713 995 8593

Thais Hamilko - Product Specialist, E&I Prod Line-LATAM,
thais.hamilko@ihs.com

Rua S3do Bento, 29 - 7° andar
Centro

Rio de Janeiro

RJ, CEP 20090-010

Brazil

Tel: (+55) 21 3299 0440

Rita Antonelli - Cost Manager, rita.antonelli@ihs.com
Matthew Butcher - Field Development Engineer,
matthew.butcher@ihs.com

John Helliwell - Engineering Advisor,
john.helliwell@ihs.com

Greville Williams - Engineering Manager,
greville.williams@ihs.com

133 Houndsditch
London

EC3A 7BX

UK

Tel: (+44) 20 3159 3300
Fax: (+44) 20 3159 3299
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S.E. Asia & Australia

China

Sanjay Sinha - APAC Field Development SME,
sanjay.sinha@ihs.com

First Floor, Tower A
Vatika Business Park
Sohan Road, Sec 49
Gurgaon 122018 - Haryana
India

Tel: (+91) 124 454 2699

Yaxing Wang - Sr. Customer Solution Advisor,
yaxing.wang@ihs.com

Room 3001

China World Office 1

No.1, JianGuoMenWai Avenue
Beijing

100004

China

Tel: (+86) 10 5633 4567
Fax: (+86) 10 5633 4500
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Copyright

Copyright© 2016, IHS Inc. and its affiliated and subsidiary companies,
ALL RIGHTS RESERVED.

Windows® and Excel® are registered trademarks of Microsoft
Corporation.

All other trademarks and service marks, including without limitation
QUE$TOR® belong to IHS Inc. and its affiliated and subsidiary
companies, all rights reserved.

This product, including software, data and documentation, is licensed to
the authorised user for its internal business purposes only and no part
thereof may be disclosed, disseminated, sold, licensed, copied,
reproduced, translated, transmitted or transferred to any third party.
All rights reserved.

IHS Inc.
15 Inverness Way East
Englewood, Colorado 80112
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